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Overview of the Reports Module
A report is a formatted view of data that exists in the APM database. Reports provide you
with a way of formatting information for display, export, and printing purposes.

You can create a report from query results, dataset results, or by importing a report that was
saved to an external location. After you create a report, you can save it and run it repeatedly.
Like other items, reports are saved in the Catalog and can be accessed via hyperlinks on a
dashboard.

To create a report, you will use APM Report Designer Plug-in for Visual Studio. If you want to
create a report within APM, Microsoft SQL Server Business Intelligence Development Studio
must be installed on the client machine.

After saving a report the Catalog, you can view the report by using the Report page. Note
that you will need the following to view reports:
• You should have configured the SQL Server Report Server.
• View/Execute permissions on the Catalog folder in which the report is located.
• At least View privileges on all families included in the underlying query or dataset.

Access the Report Page

Before You Begin
• An administrative user must create and save reports using the Reports Designer.

Procedure

In the module navigation menu, select Tools > Reports.
The Report page appears, displaying a list of all reports saved in the Catalog. The Catalog
item caption is displayed as the title to identify the report.

Overview of the Reports Page
This page displays the information about the Report:
• Name: The name of the report.
• Path : The Catalog file path where the report is saved.
• Caption: The caption of the report that you have provided in the Catalog.
• Creator : The name of the person who created the report.
• Date : The date when the report was accessed.
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On this page you can, do the following:
• View the reports that you have created.
• View the reports that you have accessed recently.
• View the reports from the Catalog folder.
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Core Analysis: Report Analysis Workflow
Core Analysis processes leverage APM data to identify opportunities for business
improvement. When the process identifies such an opportunity, a Performance
Recommendation is raised to communicate the need and track the required work. You can
use the Report Analysis Workflow process to identify opportunities or needs for improvement
based on generated reports that identify bad actors or high-impact failures.

In the following workflow diagram, the blue text in a shape indicates that a corresponding
description has been provided in the sections that follow the diagram. For more information,
refer to the topic Interpreting the Workflow Diagrams.

1. Start on page 5
2. Run the Report on page 5
3. Review Report Results on page 6
4. Opportunity Exists? on page 6
5. Manage Performance Recommendations on page 6

Start
Persona: Analyst

To satisfy a specific business problem, a APM User initiates a core analysis to apply standard
data analysis techniques.

Run the Report
Persona: Analyst

Execute a report to produce results, and modify the report design to achieve the desired
result.
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Review Report Results
Persona: Analyst

Analyze the report results. The report can identify bad actors or high impact failures for
further analysis. In the analysis of report results, consult other forms of APM data.

Opportunity Exists?
Persona: Analyst

If a APM User identifies an opportunity or need for improvement, then a Performance
Recommendation is raised to communicate the need and track the required work. Otherwise,
the workflow ends.

Manage Performance Recommendations
Persona: Analyst

If a APM User identifies an opportunity or need for improvement, then a Performance
Recommendation is raised to communicate the need and track the required work.

Refer to the Manage Performance Recommendations workflow documentation.
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About the Report Configuration Page
The Report Configuration page enables you to:
• Configure your preferred logo for the SQL Server Reporting Services (SSRS) reports.

You can change the logo to the logo of your organization or another custom image that
you prefer. By default, the GE Vernova logo appears in the SSRS report.

• Configure settings to store and manage the reports after a job for printing reports in bulk
is successful.

Access the Report Configuration Page

Procedure
• In the module navigation menu, select Admin > Operations Manager > Report

Configuration.
The Report Configuration page appears.

Configure Logo for the SSRS Reports
This topic describes how to configure the logo for the SQL Server Reporting Services (SSRS)
reports.

Procedure

1. Access the Report Configuration page.
2. In the Report Logo section, select the logo for the SSRS reports.

Note: The GE Vernova logo is selected by default.

• If you want to configure a logo other than the default GE Vernova logo:

a. Select Custom Logo, then select Choose File, and then navigate to the folder that
contains the image.
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b. Select the image that you want to configure as a logo for the SSRS reports, and then
select Open.
The image that you selected appears beside the Custom Logo button.

Note: For a logo, the size of the image must be less than or equal to 1 MB, and the image
must be in one of the following formats:
• .jpeg
• .jpg
• .bmp
• .png

3. Select .
The configured logo replaces the existing logo, and it appears in all the newly generated
SSRS reports.

Configure Storage Settings for the Reports
This topic describes how to configure the path where you want to store the printed reports,
the credentials of the machine in which the reports are stored, and the number of days after
which the reports will be deleted.

Procedure

1. Access the Report Configuration page.
2. As required, enter values in the following boxes:

a) Bulk Report Storage Path: Enter the path where you want to store the printed reports.

Note: You must create the path according to the Universal Naming Convention (UNC).
The following example provides information about the path constructed using the UNC
naming system:
• \\HostName\Share, where HostName is the host name of the computer and Share

is the name of the shared folder
b) Bulk Report Storage User Name: Enter the user name that is required to access the

machine in which the printed reports are stored.
c) Bulk Report Storage User Password: Enter a password for the user name that is

required to access the machine in which the printed reports are stored.
d) Bulk Report Storage Threshold (Days): Enter the number of days after which the .zip

file for the printed reports will be automatically deleted from the stored location.

3. Select .
The printed reports will be stored in the specified path, and you can access the machine in
which the reports are stored using the credentials that you defined.

  

 9



Chapter

4
Manage Report Designer
Topics:

• About the APM Report
Designer

• Access the APM Report
Designer

• Create a Report
• Define the Report Layout
• Deploy the Report
• Modify an Existing Report

   

10  



About the APM Report Designer
You can create new report and save it in the Catalog folder or edit an already existing report
in the Catalog folder by using the APM Report Designer in Microsoft Visual Studio.

The APM Report Designer is divided into three sections:
• APM Report Browser pane: This pane displays the Catalog folder structure. This pane

contains buttons that allow you to perform basic operations such as, Login, Logout, Open,
New and Deploy.

• Solution Explorer pane: This pane contains the details of the report that you have
created.

• Design workspace: This workspace displays the report. This workspace contains two
sections: Design and Preview. The Design section allows you to define the report layout.
When the report layout is complete, you can view the report in the Preview section.

Access the APM Report Designer
The APM Report Designer allows you to create a new report and modify the report.

Before You Begin
• Install the APM Report Designer.

Procedure

1. On the APM Server, open SQL Server Data Tools.
2. On the Tools menu, select APM Report Designer.

-or-
On the View menu, select Other Window, and then select APM Reports Browser in the
list.
The APM Reports Browser pane appears.
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3. Select Login.
4. Enter the Username and Password, and then in the DataSource list, select the

datasource.
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Note: The Login button is enabled after you enter the User Name and Password.
5. Select Login.

The Catalog folder structure appears in the APM Reports Browser pane.

  

 13



Create a Report

Procedure

1. Access the APM Report Designer.
2. In the APM Reports Browser pane, navigate to the Catalog folder where you want to save

the report. 
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3. Select New.
The Create new report window appears. The window contains two sections - The left side
displays the Catalog folder structure and the right side displays the fields.

  

 15



4. In the Create new report window, provide the following values:
• ID: Identification name of the report. The field must be unique.
• Default Caption: The caption of the report.
• Description: The description of the report.
• Datasource (Query/Dataset): Datasource for this report. You can assign a datasource

by adding a query or dataset from the Catalog folder. You can add a query or dataset
through the drag-and-drop method.

• Subreports: the sub reports that you want to assign to this report. To assign sub
reports, navigate the location that contains the report and drag and drop the report.

Note: You can not save a report in a folder, if the folder name or the parent folder name
contains the special characters such as ; ? : @ & = + , $ / * < > |. In addition, you can not
save a report in a personal folder if the user id contains the special characters. For more
information, consult MSDN documentation regarding creating, deleting or modifying a
folder.

5. Select OK.
The new report appears in the Solution Explorer pane.
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Next Steps
• Define the Report Layout.

Define the Report Layout

Before You Begin
• Create a new report.

Procedure

1. In the Solution Explorer pane, select the report that you created.
The report layout appears in the Design workspace.
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2. As needed, in the Design workspace, modify the report layout.
3. If you want display the UOM in the SSRS Report, enter the following expression in the

Report Designer.
Fields!<nameofthefield>.FormattedValue
Note: If the query used to create the reports is in formatted mode, then only the UOM will
appear in the Reports. For detailed information on formatted mode, refer to the Queries
documentation.

4. If you do not want display the UOM in the SSRS Report, enter the following expression in
the Report Designer.
Fields!<nameofthefield>.value

5. Select the Preview section to view the report layout.

Note: Enter the Login name and Password that were used to access the APM Report
Designer.

6. Select .
The report layout is defined.

Next Steps
• Deploy the Report.
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Deploy the Report

About This Task

Note: You can deploy the report after previewing. The report is then added to the Catalog
folder.

Procedure

1. In the APM Reports Browser pane, select Deploy. 

The Deploy Reports dialog box appears, displaying the list of reports and the sub reports.
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2. Select OK.
The Deploy Reports dialog box closes and the new report appears in the Catalog folder.

Modify an Existing Report

Before You Begin
• The report is already created and appears in the Catalog folder in the APM Reports

Browser workspace.

Procedure

1. In the APM Reports Browser pane, in the Catalog folder, navigate and select the report
that you want to modify.

2. Select Open.
The Create new report dialog box appears.

3. As needed, modify the following values to the fields:
• Datasource: The datasource for this report. To assign a datasource, drag and drop the

query from the Catalog folder.
• Subreports: The subreports that you want to assign to this report. To assign

subreports, navigate the location that contains the report and drag and drop the report.

Note: The ID and the Default Caption field are unique and should not be modified.
4. Select OK.

The updated report appears in the Design workspace.
5. In the APM Reports Browser pane, select Deploy to publish the changes to the Catalog

folder in the APM.
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Open a Report from the Catalog
Reports are saved in the Catalog folder and you can view the reports through Catalog.

Before You Begin
• You must have required permissions to access the Catalog folder.

Procedure

1. Access the Reports page.
2. Select Browse.

The Select a report from the catalog window appears, displaying the Catalog folder
structure.

3. Select the report, and then select Open.

Note: If the query on which the report is generated contains parameters, the Enter
Parameter Values window appears. Provide the parameter values, and then select Done
to view the report.

The selected report appears in the Report page.

View a Report

Before You Begin
• You must have privileges to view the report.

Procedure

1. Access the Report page.
2. Select the report that you want to view by selecting the link in the Path column.

The report appears.

Note: To view a translated report, in addition to setting the Security User's culture via
Security Manager, you need to set the browser language to that culture. For example, to
view a report in German language, you need to set the browser's language to German.

   

22  



Chapter

6
Manage SQL Server Reporting Services
Topics:

• About SQL Server
Reporting Services
Workspace

• Access the SQL Server
Reporting Services
Workspace

• Configure APM to Use
Reporting Server

   

 23



About SQL Server Reporting Services Workspace
The SQL Server Reporting Services stores the reports that can be viewed and managed in
APM. To integrate SQL Server Reporting Services with APM application, you must define the
SQL Server Reporting Services instance that you want to use for a given APM database.

The Operations Manager application provides a feature that lets you configure the
SQL Server Report Server. After you have defined the SQL Server Reporting Services
instance that you want to use for a given APM Server and data source, APM will use that
Report Server for storing the reports that are created and accessed on that APM Server and
database. 

Access the SQL Server Reporting Services Workspace

Procedure

1. In the module navigation menu, select Admin > Operations Manager > Connections.
2. In the Connections page, select SQL Server Reporting Services.

The SQL Server Reporting Services workspace appears.

Configure APM to Use Reporting Server

Procedure

1. Access the SQL Server Reporting Services Workspace on page 24.
2. Enter the required values in the following fields:

a) Server Name: Enter the name of the server on which SQL Server Reporting Services
(SSRS) has been installed and configured.

Note: If you do not specify the protocol for the server, HTTP will be assumed. If the SQL
Server Report Server is a secured server, you can type HTTPS://<Server Name> to
indicate that an HTTPS connection should be used. If the SQL Server Report Server is
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not secured, you can type HTTP://<Server Name> or you can omit the protocol and
simply type the server name.

Note: In the Data Source page, specify the Data Source Host value as “*” by default.
But when you are configuring https, enter a valid Fully Qualified Domain Name (FQDN)
in the Data Source Host field.

b) Web Service: Enter the name of the Report Server Virtual Directory that has been
created for the instance of SSRS that you want to use for the current APM Server and
data source.

If the SQL Server Report Server for this data source has not been defined, the Web
Service will be set to Report Server by default, which is the name of the virtual
directory created for the first SQL Server Reporting Service instance that is installed on
the given server. You can modify the default value if needed.

If the server specified in the Report Server text box contains multiple instances of
SSRS, you must specify the virtual directory of the instance that you want to use for
the current APM Server and data source.

c) User Name: Enter the user name to access SSRS.
d) User Password: Enter the password to access SSRS.
e) User Domain: Enter the domain name to access SSRS.

3. Select .
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Deployment and Upgrade
Deployment and Upgrade content for various APM modules has been consolidated into a
single document. For more information, refer to the module-specific information in the APM
Module Deployment and Upgrade document.
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System Requirements

Reports System Requirements

License Requirements

This feature is available with the core APM application; no specific license is required.

Additional Components Required

In addition to the basic APM system architecture, your system must also contain the following
additional components:

• Microsoft Visual Studio 2017 or 2019 Professional.
• Microsoft SQL Server Data Tools - Business Intelligence for Microsoft Visual Studio 2017
(15.8.0) or 2019.

• APM SSRS Data Processing Extension plugin for Visual Studio from the Admin Installer.

Deploying Reports

After you have installed and configured the basic APM system architecture, configure
Reports.

SQL Server Analysis Services System Requirements

Hardware Requirements

The following hardware requirements outline the minimum hardware required for SQL Server
Analysis Services support in APM Metrics and Scorecards module. These requirements
account for the APM software only. Additional hardware may be required on a SQL Server
Analysis Services machine where other components are installed. These requirements may
not be sufficient, depending upon how your system is configured.
• Two Processor Cores, 2+ GHz
• 8 GB RAM
• 25 GB of available hard drive space

Software Requirements

The following software components are required on any machine that will serve as the SQL
Server Analysis Services server.

Software Name and Version Where You Can Obtain It Required?

SQL Server Reporting Services 2012
(Multi-Dimensional mode only)

-or-

SQL Server Reporting Services 2014
(Multi-Dimensional mode only)

Microsoft Yes
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SQL Server Report Server System Requirements

Hardware Requirements

The following hardware requirements outline the minimum hardware required for any machine
that will serve as the SQL Server Report Server. These requirements account for the APM
software only. Additional hardware may be required on a SQL Server Report Server machine
where other components are installed. These requirements may not be sufficient, depending
upon how your system is configured.
• Two Processor Cores, 2+ GHz
• 8 GB RAM
• 25 GB of available hard drive space

If you are using a virtual machine (VM) to host your SQL Server Report Server, we
recommend that:
• You increase the physical server CPU and hard drive space requirements by 20% to ensure

that the application will perform equivalently in a virtualized environment.
• You double the physical server memory requirements.
• Each VM have its own dedicated processor cores and memory allocation to ensure

appropriate performance.

APM supports Hyper-V and VMWare platforms.

These requirements may not be sufficient, depending on how your system is configured.
Parameters that affect the hardware requirements include the number of users, modules
purchased, database size, and other factors that can vary from one customer to another. For
help refining your specific system requirements, consult a member of the APM Professional
Services department.

Software Requirements

The following software components are required on any machine that will serve as the SQL
Server Report Server.

Software Name and
Version

Where You Can Obtain It Required? Behavior of Meridium APM
Server and Add-ons
Installer

SQL Server Reporting
Services 2012

-or-

SQL Server Reporting
Services 2014

-or-

SQL Server Reporting
Services 2016

Microsoft Yes If it is not found, the
installer will close.
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Reports URLs

Reports URLs
There is one URL route associated with reports: ssrs/viewer. The following table describes
the various paths that build on the route, and the elements that you can specify for each.

Element Description Accepted Value(s) Syntax

Catalog Item Path Specifies the path and
name of the report that
you want to open.

Catalog item path #ssrs/viewer/
Catalog Path

The following SSRS report hyperlink formats are supported:
• #ssrs/viewer/<CATALOG-PATH-HERE>/P0={1}/P1={2}/P2={3}
• #ssrs/viewer/<CATALOG-PATH-HERE>?P0={1}&P1={2}&P2={3}

Example: Reports URLs

Example URL Destination

#ssrs/viewer/Public\Meridium
\Modules\RCA\SSRS
\ComprehensiveAnalysis

Opens the report named 'Comprehensive Analysis' in the
Report Viewer.
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